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Abstract.  Bruising is a common form of mechanical damage occurring in bananas 

during transport that can reduce fruit quality. This study aimed to determine the optimal 

threshold for measuring banana bruise areas using digital image analysis and to 

evaluate the effects of vibration frequency and duration on bruise development during 

storage. The percentage of bruised area was derived from image segmentation using 

ImageJ at threshold values of 120, 130, 140, 150, and 160. The optimal threshold was 

selected using Principal Component Analysis (PCA), while treatment effects were 

analyzed using analysis of variance (ANOVA) and Duncan’s post-hoc test. PCA results 

indicated that all thresholds were strongly correlated and represented similar 

information; consequently, a threshold of 150 was selected as the best option based on 

statistical results and visual evaluation of the segmentation. ANOVA results showed that 

the interaction between vibration frequency and duration had a highly significant effect 

on the percentage of bruised area, whereas duration alone did not have a significant 

effect. Duncan’s test revealed that the 10 Hz–60 minute combination resulted in the 

lowest percentage of bruised area, while the 30 Hz–60 minute combination resulted in 

the highest. This study demonstrates that a threshold of 150 can serve as a basis for 

quantifying banana bruising and that the extent of bruising during transport simulation 

is influenced by the combination of vibration frequency and duration. 
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1. Pendahuluan 

Pisang merupakan salah satu komoditas hortikultura penting yang banyak dibudidayakan dan 

dikonsumsi di berbagai negara tropis, termasuk Indonesia. Buah ini memiliki nilai ekonomi yang 

tinggi karena kandungan nutrisi yang baik, ketersediaan sepanjang tahun, serta permintaan pasar 

yang terus meningkat. Namun demikian, pisang termasuk buah klimakterik yang rentan mengalami 

penurunan mutu selama proses panen, penanganan pascapanen, transportasi, dan distribusi. Berbagai 

faktor selama rantai pasok dapat menyebabkan kerusakan fisik yang berdampak pada penurunan 

kualitas dan nilai jual buah (Al Dairi et al., 2021). 

Pisang merupakan komoditas hortikultura yang sangat rentan mengalami penurunan mutu 

selama penanganan pascapanen, terutama pada tahap distribusi dan transportasi. Sebagai buah 

klimakterik, pisang terus mengalami perubahan fisiologis setelah panen sehingga kualitasnya sangat 

dipengaruhi oleh kondisi lingkungan dan perlakuan mekanis selama rantai pasok. Menurut Sugianti 

et al. (2022), keberhasilan penanganan pascapanen pisang sangat ditentukan oleh penerapan 

teknologi yang mampu mempertahankan mutu buah, mengurangi kehilangan hasil, dan menekan 

kerusakan selama distribusi. Dalam konteks ini, kerusakan mekanis seperti memar menjadi salah satu 

masalah utama karena tidak hanya menurunkan penampilan buah, tetapi juga mempercepat 

kemunduran mutu dan mengurangi nilai jual produk. 

Salah satu bentuk kerusakan yang sering ditemukan pada buah pisang adalah kerusakan 

mekanis berupa memar (bruising). Kerusakan ini dapat terjadi akibat benturan, tekanan, getaran, atau 

gesekan selama proses penanganan dan distribusi. Menurut Opara dan Pathare (2014), memar 

merupakan salah satu penyebab utama kehilangan kualitas pada produk hortikultura segar karena 

dapat memicu kerusakan jaringan, perubahan warna, peningkatan laju respirasi, dan percepatan 

proses pembusukan. Pada buah pisang, memar umumnya ditandai dengan munculnya area berwarna 

cokelat hingga kehitaman yang menyebabkan penurunan kualitas visual dan daya terima konsumen 

(Pathare et al., 2022). 

Penilaian kerusakan mekanis pada buah umumnya masih dilakukan melalui pengamatan 

visual. Meskipun metode ini mudah diterapkan, hasil yang diperoleh sering kali bersifat subjektif 

karena dipengaruhi oleh pengalaman dan persepsi masing-masing pengamat. Selain itu, pengukuran 

luas memar secara manual memerlukan waktu yang relatif lama dan sulit diterapkan pada jumlah 

sampel yang besar. Keterbatasan tersebut mendorong perlunya metode evaluasi yang lebih objektif, 

cepat, dan mampu menghasilkan data kuantitatif untuk mendukung pengendalian mutu produk 

hortikultura (Huseain, 2020). 

Selain faktor mekanis, kondisi suhu selama penyimpanan dan distribusi juga memegang 

peranan penting terhadap stabilitas mutu pisang. Penelitian Sugianti et al. (2024) menunjukkan 

bahwa pisang hijau memiliki batas toleransi tertentu terhadap suhu tinggi, dan paparan suhu yang 

melebihi ambang toleransi dapat mempercepat penurunan mutu buah. Hal ini menunjukkan bahwa 

mutu pisang selama distribusi dipengaruhi oleh kombinasi faktor fisiologis dan lingkungan, termasuk 

suhu serta tekanan mekanis yang diterima buah. Oleh karena itu, kajian mengenai perkembangan 

memar pisang akibat perlakuan getaran selama simulasi transportasi menjadi penting untuk 

dilakukan, karena dapat memberikan dasar ilmiah dalam merancang sistem distribusi yang lebih 

aman dan efektif untuk mempertahankan mutu pisang pascapanen. 

Perkembangan teknologi pengolahan citra digital (digital image processing) telah membuka 

peluang baru dalam bidang penilaian mutu produk pertanian secara non-destruktif. Teknologi ini 

memungkinkan ekstraksi informasi visual dari suatu objek melalui analisis parameter warna, tekstur, 

bentuk, maupun luas area kerusakan. Berbagai penelitian menunjukkan bahwa analisis citra digital 

dapat digunakan untuk mendeteksi dan mengukur kerusakan pada buah dengan tingkat akurasi yang 

tinggi serta waktu analisis yang relatif singkat (Dua, Z et al., 2020). Oleh karena itu, metode ini 

semakin banyak dimanfaatkan dalam kegiatan inspeksi mutu produk hortikultura. 
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Salah satu perangkat lunak yang banyak digunakan dalam analisis citra adalah ImageJ. 

Perangkat lunak ini dikembangkan sebagai perangkat lunak sumber terbuka (open source) yang 

menyediakan berbagai fungsi untuk pengolahan dan analisis citra, seperti segmentasi objek, 

pengukuran luas area, analisis warna, dan ekstraksi fitur visual lainnya. Keunggulan ImageJ terletak 

pada kemudahan penggunaan, fleksibilitas, serta kemampuannya untuk menghasilkan data 

kuantitatif tanpa memerlukan perangkat keras yang mahal. Penelitian yang dilakukan oleh Al-Dairi 

et al. (2024) menunjukkan bahwa analisis citra digital menggunakan perangkat lunak terbuka dapat 

digunakan untuk mengidentifikasi dan mengukur tingkat kerusakan mekanis pada buah secara 

efektif. 

Penerapan analisis citra digital menggunakan ImageJ berpotensi menjadi solusi sederhana dan 

ekonomis dalam kuantifikasi kerusakan mekanis pada buah pisang. Dengan memanfaatkan citra yang 

diperoleh dari kamera digital atau telepon pintar, luas area memar dapat dihitung secara objektif 

sehingga menghasilkan informasi yang lebih akurat dibandingkan pengamatan visual semata. Selain 

itu, pendekatan ini dapat mendukung pengembangan sistem penilaian mutu berbasis teknologi 

informasi yang lebih efisien dan mudah diterapkan pada skala laboratorium maupun industri. 

Berdasarkan latar belakang tersebut, penelitian ini bertujuan untuk menerapkan analisis citra 

digital menggunakan perangkat lunak ImageJ dalam mengkuantifikasi kerusakan mekanis pada buah 

pisang. Hasil penelitian diharapkan dapat memberikan alternatif metode non-destruktif yang objektif, 

praktis, dan berbiaya rendah untuk mendukung evaluasi mutu buah pisang selama penanganan 

pascapanen. 

 

2. Metode Penelitian 

Penelitian ini menggunakan satu unit Transportation Tester BF50UT (IDEX Co., Ltd.) sebagai alat 

untuk mensimulasikan getaran selama proses transportasi buah pisang. Dokumentasi dan akuisisi 

citra dilakukan menggunakan kamera digital CANON EOS Kiss X7. Analisis citra untuk mengukur 

tingkat kerusakan mekanis berupa memar pada buah pisang dilakukan menggunakan perangkat lunak 

ImageJ. Bahan yang digunakan dalam penelitian adalah buah pisang yang dikemas dalam satu kotak 

(box) berkapasitas 10 kg. 

Penelitian menggunakan rancangan faktorial dengan dua faktor, yaitu frekuensi 

getaran dan lama getaran. Faktor pertama adalah frekuensi getaran yang terdiri atas tiga taraf, 

yaitu 10 Hz, 20 Hz, dan 30 Hz. Faktor kedua adalah durasi getaran yang terdiri atas tiga taraf, yaitu 30 

menit, 60 menit, dan 90 menit. Kombinasi kedua faktor menghasilkan sembilan perlakuan simulasi 

transportasi. 

 

2.1 Prosedur Simulasi Transportasi 

Buah pisang yang telah dikemas dalam kotak berkapasitas 10 kg ditempatkan pada meja getar 

Transportation Tester BF50UT. Sebelum perlakuan, kondisi fisik buah didokumentasikan 

menggunakan kamera digital CANON EOS Kiss X7 untuk memperoleh citra awal sebagai data 

pembanding. 

Simulasi transportasi dilakukan dengan memberikan getaran sesuai kombinasi perlakuan 

frekuensi dan durasi yang telah ditentukan. Frekuensi getaran diatur pada 10 Hz, 20 Hz, atau 30 Hz, 

sedangkan lama paparan getaran diatur selama 30 menit, 60 menit, atau 90 menit. Selama proses 

simulasi, kotak berisi pisang dibiarkan menerima getaran secara kontinu hingga waktu perlakuan 

tercapai. 

Setelah simulasi selesai, buah pisang dikeluarkan dari kemasan dan disimpan dalam inkubator 

dengan suhu 15C untuk diamati gejala memar secara visual. Selanjutnya, setiap buah 

didokumentasikan menggunakan kamera digital dengan kondisi pencahayaan dan jarak pengambilan 

gambar yang seragam. Citra yang diperoleh kemudian dianalisis menggunakan perangkat 
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lunak ImageJ untuk mengidentifikasi dan mengukur luas area memar yang muncul akibat perlakuan 

getaran. 

 

2.2 Prosedur Pengolahan Citra  

2.2.1 Pengambilan Citra 

Buah pisang yang telah mengalami perlakuan kerusakan mekanis difoto menggunakan kamera digital 

dengan posisi kamera tegak lurus terhadap objek pada jarak yang tetap. Pengambilan gambar 

dilakukan di dalam kotak pencahayaan (light box) atau pada kondisi pencahayaan yang seragam 

untuk meminimalkan pengaruh bayangan dan variasi intensitas cahaya. Setiap buah diletakkan pada 

latar belakang berwarna putih untuk memudahkan proses segmentasi objek. Citra disimpan dalam 

format JPEG dengan resolusi yang sama untuk seluruh sampel. 

 

2.2.2 Pra-pemrosesan Citra 

Citra yang diperoleh kemudian dianalisis menggunakan perangkat lunak ImageJ versi 1.54. Tahap 

awal analisis dilakukan dengan membuka citra pada ImageJ dan melakukan kalibrasi skala 

menggunakan objek referensi yang diketahui dimensinya. Kalibrasi dilakukan melalui menu Analyze 

→ Set Scale sehingga hasil pengukuran dapat dinyatakan dalam satuan luas aktual (cm²). 

Selanjutnya dilakukan pemotongan (cropping) pada area yang berisi objek pisang untuk 

menghilangkan bagian latar belakang yang tidak diperlukan. Jika diperlukan, citra dikonversi ke 

format 8-bit atau ruang warna RGB guna memudahkan proses segmentasi area memar. 

 

2.2.3 Segmentasi Area Memar 

Segmentasi bertujuan memisahkan area memar dari jaringan buah yang masih normal. Proses ini 

dilakukan menggunakan fitur Color Threshold pada ImageJ melalui menu Image → Adjust → Color 

Threshold. Nilai ambang (threshold) ditentukan berdasarkan perbedaan warna antara area memar 

yang cenderung berwarna cokelat gelap dengan permukaan buah yang masih normal. 

Setelah parameter ambang ditentukan, area memar akan ditampilkan sebagai wilayah terpilih 

(selected area). Hasil segmentasi kemudian dikonversi menjadi citra biner (binary image) sehingga 

area memar dan area normal dapat dibedakan dengan jelas. 

 

2.3 Prosedur Penentuan Luas Area Menggunakan ImageJ 

Analisis citra dilakukan menggunakan perangkat lunak ImageJ untuk menentukan luas permukaan 

buah pisang dan area kerusakan yang diamati. Citra digital buah pisang terlebih dahulu dimasukkan 

ke dalam perangkat lunak ImageJ dengan metode drag and drop. Setelah citra terbuka, gambar 

dikonversi menjadi tumpukan kanal warna RGB (RGB Stack) melalui menu Image → Type → RGB 

Stack sehingga diperoleh tiga kanal warna, yaitu merah (red), hijau (green), dan biru (blue). 

Kanal warna biru (blue channel) kemudian dipilih untuk proses analisis karena memberikan 

kontras yang lebih baik antara objek pisang dan latar belakang. Selanjutnya, kualitas citra 

ditingkatkan menggunakan fitur Enhance Contrast melalui menu Process → Enhance 

Contrast dengan nilai saturated pixel sebesar 0,5%. Tahap ini bertujuan untuk meningkatkan 

perbedaan intensitas warna antara objek dan latar belakang sehingga memudahkan proses 

segmentasi. 

Setelah peningkatan kontras dilakukan, batas permukaan buah pisang ditentukan 

menggunakan Wand Tool. Nilai tolerance disesuaikan secara bertahap hingga seluruh area 

permukaan pisang dapat terseleksi secara akurat tanpa mencakup area latar belakang. Seleksi yang 

diperoleh digunakan sebagai representasi luas permukaan buah yang akan diukur. 

Pengukuran luas dilakukan dengan mengaktifkan parameter area melalui menu Analyze → Set 

Measurements dan memilih opsi Area. Setelah parameter pengukuran ditetapkan, luas permukaan 
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buah yang telah terseleksi dihitung menggunakan perintah Measure pada menu Analyze → Measure. 

Hasil pengukuran kemudian ditampilkan dalam jendela Results berupa nilai luas area yang digunakan 

sebagai data untuk analisis lebih lanjut. Prosedur pengukuran dapat dilihat pada Gambar 1. 

 
Gambar 1. Prosedur penentuan luas area pisang menggunakan ImageJ 

 

2.4 Penentuan Area Memar pada Buah Pisang Menggunakan ImageJ 

Setelah luas total permukaan buah pisang diperoleh, analisis dilanjutkan untuk menentukan luas area 

memar atau area berwarna gelap pada permukaan buah. Kanal warna hijau (green stack) dari citra 

RGB dipilih karena mampu memberikan kontras yang lebih jelas antara area memar dan jaringan 

buah yang masih normal. Selanjutnya, batas permukaan buah pisang ditentukan menggunakan Wand 

Tool dengan penyesuaian nilai tolerance hingga seluruh area permukaan buah terseleksi secara 

akurat. 

Untuk mengidentifikasi area memar, dilakukan proses thresholdin melalui menu Image → 

Adjust → Threshold. Nilai ambang (threshold) disesuaikan hingga area memar atau area berwarna 

hitam pada permukaan pisang dapat tersegmentasi dengan jelas dari area normal. Hasil segmentasi 

menghasilkan citra biner yang membedakan area memar dan area non-memar berdasarkan perbedaan 

intensitas warna. 

Luas area memar kemudian dihitung menggunakan fitur Analyze Particles melalui menu 

Analyze → Analyze Particles. Pada tahap ini, opsi Summary dan Add to Manager dipilih untuk 

memperoleh ringkasan hasil pengukuran sekaligus menyimpan area yang teridentifikasi. Hasil 

analisis memberikan informasi mengenai luas total area berwarna hitam (memar) pada permukaan 

buah pisang. 
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Gambar 2. Prosedur penentuan luas memar pisang menggunakan ImageJ 

 

2.5 Perhitungan Persentase Memar 

Persentase area memar dihitung dengan membandingkan luas area memar terhadap luas total 

permukaan buah pisang menggunakan persamaan berikut: 

 

Persentase Area Memar (%) =
Luas Area Memar

Luas Total Permukaan Buah
× 100   (1)  

 

dimana luas area memar adalah total luas area berwarna hitam yang teridentifikasi pada permukaan 

pisang (cm²), luas total permukaan buah adalah luas keseluruhan permukaan pisang yang terukur 

pada citra (cm²). 

 

Nilai persentase area memar yang diperoleh digunakan sebagai indikator tingkat kerusakan 

mekanis pada buah pisang akibat perlakuan yang diberikan. Semakin besar persentase area memar, 

semakin tinggi tingkat kerusakan mekanis yang dialami oleh buah. 

 

2.6 Analisis Data 

Data luas memar dan persentase kerusakan mekanis dari setiap sampel direkap dalam lembar kerja 

spreadsheet untuk dianalisis lebih lanjut. Penentuan threshold terbaik dilakukan melalui analisis data 

persentase area memar hasil segmentasi citra pada beberapa nilai threshold, yaitu 120, 130, 140, 150, 

dan 160. Data persentase area memar dari masing-masing threshold dianalisis menggunakan 

Principal Component Analysis (PCA) untuk mengevaluasi hubungan antar-threshold, mengetahui 

tingkat redundansi informasi, dan menentukan threshold yang paling representatif. Sebelum PCA 

dilakukan, kelayakan data diuji menggunakan Kaiser-Meyer-Olkin (KMO) dan Bartlett’s Test of 

Sphericity. Pemilihan threshold terbaik didasarkan pada nilai loading komponen utama, kontribusi 

terhadap keragaman total, serta hasil evaluasi visual segmentasi citra untuk memastikan threshold 

yang dipilih mampu mengekstraksi area memar secara akurat dan stabil. Threshold terpilih kemudian 

digunakan sebagai variabel respons pada analisis statistik lanjutan. Data threshold terbaik dianalisis 

menggunakan analisis ragam (ANOVA) pada taraf signifikansi 5% untuk mengetahui pengaruh 

perlakuan terhadap tingkat kerusakan mekanis buah pisang. 
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3. Hasil dan Pembahasan 

3.1 Analisis Principal Component Analysis (PCA) dan pemilihan Threshold 

Pemilihan threshold terbaik merupakan tahap penting dalam analisis citra memar pisang, karena nilai 

threshold yang digunakan akan menentukan ketepatan segmentasi area memar dari latar belakang 

kulit buah. Pada penelitian ini dilakukan screening threshold pada rentang 120 sampai 160 untuk 

memperoleh nilai ambang yang paling representatif dalam mengekstraksi area memar pisang hasil 

simulasi transportasi. Rentang threshold tersebut dipilih karena berada pada kisaran intensitas yang 

secara visual masih mampu membedakan area memar berwarna gelap dari jaringan kulit pisang yang 

normal, namun tetap berpotensi menghasilkan perbedaan sensitivitas segmentasi. Threshold yang 

terlalu rendah dapat menyebabkan sebagian area memar tidak terdeteksi (under-segmentation), 

sedangkan threshold yang terlalu tinggi dapat memperluas area hasil segmentasi hingga memasukkan 

bayangan, noise, atau bagian kulit normal sebagai area memar (over-segmentation). Screening 

threshold dilakukan untuk menyeleksi nilai ambang yang paling sesuai sehingga hasil pengukuran 

persentase area memar dapat digunakan secara lebih akurat pada analisis statistik selanjutnya. 

Gambar 3 adalah nilai area memar pada masing masing threshold yang diaplikasikan.  

Kemudian data persentase area memar pada threshold 120, 130, 140, 150, dan 160 dianalisis 

menggunakan Principal Component Analysis (PCA). Analisis ini dilakukan untuk melihat hubungan 

antar-threshold, mengidentifikasi adanya redundansi informasi, serta menentukan threshold yang 

paling representatif untuk digunakan pada analisis lanjutan. Hasil PCA menunjukkan bahwa seluruh 

threshold memiliki korelasi yang sangat kuat dan cenderung merepresentasikan satu dimensi 

informasi yang sama, yaitu tingkat memar pisang. Komponen utama pertama mampu menjelaskan 

sebagian besar keragaman data, sehingga menunjukkan bahwa variasi persentase area memar pada 

threshold 120–160 pada dasarnya menggambarkan fenomena yang serupa. Dengan demikian, 

pemilihan threshold terbaik tidak hanya didasarkan pada besarnya kontribusi statistik terhadap 

komponen utama, tetapi juga mempertimbangkan kualitas segmentasi visual agar threshold yang 

dipilih mampu mengekstraksi area memar secara akurat, konsisten, dan minim noise.  

Analisis Principal Component Analysis (PCA) dilakukan terhadap data persentase area memar 

pisang yang diperoleh dari hasil segmentasi citra pada lima nilai threshold, yaitu 120, 130, 140, 150, 

dan 160. Tujuan analisis ini adalah untuk mengevaluasi hubungan antar-threshold, mengetahui 

tingkat redundansi informasi yang dihasilkan oleh masing-masing threshold, serta memilih threshold 

yang paling representatif untuk analisis lanjutan. Pendekatan ini relevan karena dalam analisis citra, 

beberapa nilai threshold yang berdekatan sering kali menghasilkan informasi yang saling berkorelasi, 

sehingga diperlukan metode reduksi dimensi untuk mengidentifikasi variabel yang paling mewakili 

variasi data secara keseluruhan. PCA telah banyak digunakan dalam pengolahan citra untuk 

mengekstraksi informasi utama, mereduksi dimensi data, serta memilih fitur atau kanal yang paling 

informatif dalam deteksi kerusakan atau cacat pada buah (Mei & Li, 2023; Wu et al., 2020). 

 

 



J. Agricultural Biosystem Engineering  Vol. 5 No. 2 
 
 

Hidayat dan Sugianti , 2026  210 
 

 

Gambar 3. Persentase area memar dengan aplikasi perbedaan threshold 

 

Hasil PCA menunjukkan bahwa data threshold layak dianalisis lebih lanjut, yang ditunjukkan 

oleh nilai Kaiser-Meyer-Olkin (KMO) sebesar 0,632 dan Bartlett’s Test of Sphericity yang 

signifikan (p < 0,001). Nilai tersebut mengindikasikan bahwa antar-variabel threshold terdapat 

korelasi yang cukup kuat sehingga PCA dapat diterapkan untuk merangkum struktur informasi pada 

data. Matriks korelasi juga memperlihatkan bahwa seluruh threshold memiliki hubungan yang sangat 
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kuat, dengan koefisien korelasi berkisar antara 0,868–0,992. Korelasi yang sangat tinggi ini 

menunjukkan bahwa threshold 120–160 pada dasarnya mengukur fenomena yang sama, yaitu luas 

area memar pisang, meskipun dengan sensitivitas segmentasi yang sedikit berbeda. Dalam konteks 

pengolahan citra, kondisi ini umum terjadi ketika beberapa nilai threshold berada pada rentang 

intensitas yang berdekatan, sehingga perbedaan hasil segmentasi lebih bersifat kuantitatif daripada 

kualitatif. Thresholding sendiri merupakan metode segmentasi yang memisahkan objek dari latar 

berdasarkan nilai intensitas, sehingga perbedaan kecil pada nilai ambang dapat menghasilkan luasan 

objek yang berbeda, tetapi tetap berada pada pola informasi yang sama (Abd et al., 2023; Petrellis, 

2018). 

Berdasarkan hasil ekstraksi komponen utama, diperoleh bahwa komponen utama pertama 

(PC1) memiliki eigenvalue 4,831 dan mampu menjelaskan 96,32% total keragaman data, sedangkan 

komponen kedua hanya menjelaskan 3,41% (Gambar 4 dan Tabel 1). Dominasi PC1 yang sangat 

tinggi menunjukkan bahwa hampir seluruh variasi pada nilai persentase area memar hasil 

threshold 120–160 dapat direpresentasikan hanya oleh satu komponen utama. Dengan demikian, 

seluruh threshold tersebut dapat dipandang sebagai serangkaian pengukuran yang sangat serupa 

terhadap satu konstruk yang sama, yaitu intensitas memar. Temuan ini sejalan dengan berbagai studi 

pengolahan citra pertanian yang menunjukkan bahwa PCA efektif untuk mengidentifikasi kanal, 

panjang gelombang, atau fitur citra yang paling relevan dalam mendeteksi memar, sekaligus 

mengurangi redundansi informasi antar-variabel citra (Mei & Li, 2023; Wu et al., 2020). 

 

 
Gambar 4. Nilai hasil Scree Plot 

 

Nilai loading pada komponen utama pertama juga menunjukkan pola yang sangat seragam, 

yaitu 0,442 untuk T120; 0,451 untuk T130; 0,455 untuk T140; 0,451 untuk T150; dan 0,437 untuk 

T160. Loading yang relatif setara mengindikasikan bahwa seluruh threshold memberikan kontribusi 

yang hampir sama besar dalam membentuk komponen utama memar. Dengan kata lain, secara 

statistik tidak terdapat satu threshold yang secara mutlak paling dominan dibanding threshold 

lainnya. Oleh karena itu, pemilihan threshold terbaik tidak dapat didasarkan pada nilai loading PCA 

semata, tetapi perlu mempertimbangkan kualitas segmentasi visual agar threshold yang dipilih tidak 

hanya representatif secara statistik, tetapi juga akurat dalam mengekstraksi area memar yang 

sebenarnya. Prinsip ini sejalan dengan literatur segmentasi citra, di mana pemilihan threshold yang 

baik harus mempertimbangkan keseimbangan antara kemampuan memisahkan objek dari latar 

belakang, meminimalkan noise, serta mempertahankan bentuk area target secara realistis. Pada 

deteksi memar buah, threshold yang terlalu rendah dapat menyebabkan area memar tidak 

tersegmentasi secara utuh, sedangkan threshold yang terlalu tinggi berpotensi menimbulkan over-
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segmentation dan memasukkan area non-memar ke dalam objek hasil segmentasi (Lu & Lu, 2017; 

Ünal et al., 2024). 

 

Tabel 1. Hasil analisis PCA 

Komponen Eigenvalue % Variance Kumulatif % 

PC1 4,831 96,32 96,32 

PC2 0,171 3,41 99,73 

PC3 0,012 0,25 99,98 

PC4 0,001 0,02 100,00 

PC5 0,000 0,00 100,00 

 

Berdasarkan kombinasi hasil PCA dan pertimbangan metodologis pengolahan citra, threshold 

140 dan 150 merupakan kandidat yang paling rasional untuk dipilih sebagai threshold representatif. 

Kedua threshold tersebut berada pada rentang tengah sehingga secara teoritis memiliki peluang lebih 

baik untuk menyeimbangkan dua risiko segmentasi, yaitu under-segmentation pada threshold yang 

terlalu rendah dan over-segmentation pada threshold yang terlalu tinggi. Threshold yang terlalu 

rendah dapat menyebabkan sebagian area memar tidak terdeteksi, sedangkan threshold yang terlalu 

tinggi berisiko memasukkan area non-memar, bayangan, atau noise sebagai bagian dari memar. 

Karena nilai loading T140 (0,455) merupakan yang tertinggi, threshold ini secara statistik sedikit 

lebih representatif dibanding threshold lainnya. Namun, karena perbedaan loading antar-threshold 

sangat kecil, keputusan akhir lebih tepat ditetapkan berdasarkan evaluasi visual hasil segmentasi. 

Apabila hasil segmentasi pada threshold 140 menunjukkan batas memar yang lebih sesuai dengan 

kondisi nyata buah, maka threshold 140 dapat dipilih sebagai threshold utama. Sebaliknya, jika 

threshold 150 memberikan area segmentasi yang lebih stabil, lebih utuh, dan lebih sedikit noise, 

maka threshold 150 lebih layak digunakan pada analisis lanjutan. Dengan demikian, PCA berfungsi 

sebagai dasar objektif untuk menunjukkan bahwa seluruh threshold berada pada satu dimensi 

informasi yang sama, sedangkan pemilihan threshold akhir dilakukan melalui integrasi antara hasil 

PCA dan validasi visual citra (Lu & Lu, 2017; Mei & Li, 2023). 

 

3.2 Perkembangan Area Memar Selama Penyimpanan 

 

0

3

6

9

12

15

18

21

0 2 4 6 8

A
re

a 
m

em
ar

 (
%

)

Waktu Penyimpanan (Hari)

10 Hz/0.49 G

Control 30 minutes 60 minutes 90 minutes



J. Agricultural Biosystem Engineering  Vol. 5 No. 2 
 
 

Hidayat dan Sugianti , 2026  213 
 

 

 
Gambar 5. Perkembangan area kerusakan mekanis selama penyimpanan pada perbedaan nilai 

getaran 

  

Hasil analisis Anova menunjukkan bahwa model yang digunakan untuk menganalisis 

persentase area memar pisang pada threshold 150 (T150) secara keseluruhan berpengaruh nyata, 

yang ditunjukkan oleh nilai F = 3,025 dengan p = 0,003 yang ditamplkan pada Tabel 2. Hal ini 

menunjukkan bahwa kombinasi faktor yang dimasukkan ke dalam model, yaitu frekuensi 

getaran, durasi getaran, dan interaksi keduanya, secara bersama-sama mampu menjelaskan variasi 

persentase area memar pisang. Namun demikian, nilai R² sebesar 0,073 menunjukkan bahwa model 

hanya mampu menjelaskan sekitar 7,3% keragaman data, sedangkan sisanya dipengaruhi oleh faktor 

lain di luar model atau oleh variasi alami antar buah. Nilai Adjusted R² sebesar 0,049 juga 

mengindikasikan bahwa kontribusi model terhadap keragaman data relatif kecil, sehingga meskipun 

secara statistik model signifikan, kekuatan penjelasannya terhadap variasi memar masih terbatas. 
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Tabel 2. Hasil analisis sidik ragam (Anova) 

Sumber 

Keragaman 

db Jumlah 

Kuadrat 

Kuadrat 

Tengah 

F hitung Pvalue 

Frekuensi 2 190,632 95,316 3,008 0,051 

Durasi 2 2,575 1,288 0,041 0,960 

Frekuensi*Durasi 4 573,775 143,444 4,526 0,001 

Error 306 9697,997 31,693   

Total 315 1.6868,098    
 

Secara parsial, faktor frekuensi getaran menunjukkan nilai F = 3,008 dengan p = 0,051. Nilai 

signifikansi ini berada sangat dekat dengan batas nyata 5%, sehingga dapat dikatakan bahwa 

frekuensi getaran cenderung berpengaruh terhadap persentase area memar, meskipun secara 

statistik belum signifikan pada taraf 5%. Dengan kata lain, perubahan tingkat frekuensi getaran 

memberikan kecenderungan perubahan luas area memar, tetapi pengaruh tersebut belum cukup kuat 

untuk dinyatakan berbeda nyata secara statistik. Kondisi ini dapat disebabkan oleh variasi respons 

antar buah yang cukup besar, sehingga perbedaan akibat frekuensi belum sepenuhnya terpisah dari 

galat percobaan. Dalam konteks fisiologi pascapanen, frekuensi getaran yang lebih tinggi secara 

teoritis dapat meningkatkan peluang terjadinya benturan antar buah maupun antara buah dengan 

dinding kemasan, yang pada akhirnya memperbesar kerusakan mekanis dan memicu pembentukan 

memar. Namun, pada data ini pengaruh tersebut tampaknya belum konsisten di seluruh kombinasi 

perlakuan. 

Faktor durasi getaran menunjukkan nilai F = 0,041 dengan p = 0,960yang berarti tidak 

berpengaruh nyata terhadap persentase area memar T150. Hasil ini menunjukkan bahwa perbedaan 

lama pemberian getaran pada taraf durasi yang diuji belum menghasilkan perbedaan luas area memar 

yang berarti secara statistik. Dengan demikian, jika durasi dilihat sebagai faktor tunggal, peningkatan 

lama getaran tidak selalu diikuti oleh peningkatan area memar. Kemungkinan hal ini terjadi karena 

respons memar tidak hanya dipengaruhi oleh lamanya getaran, tetapi lebih dipengaruhi oleh 

kombinasi antara intensitas getaran, kondisi fisik buah, posisi buah dalam kemasan, dan tingkat 

kematangan buah selama penyimpanan. Oleh karena itu, durasi getaran secara tunggal belum mampu 

menjelaskan variasi memar pada pisang dalam penelitian ini. 

Berbeda dengan kedua efek utama tersebut, interaksi antara frekuensi getaran dan durasi 

getaran menunjukkan hasil yang berpengaruh sangat nyata, dengan nilai F = 4,526 dan p = 0,001. 

Hasil ini merupakan temuan penting, karena menunjukkan bahwa pengaruh frekuensi getaran 

terhadap persentase area memar bergantung pada durasi getaran yang diberikan, demikian pula 

sebaliknya. Dengan kata lain, efek frekuensi tidak dapat diinterpretasikan secara terpisah tanpa 

mempertimbangkan durasi, karena kombinasi tertentu antara frekuensi dan durasi dapat 

menghasilkan tingkat memar yang berbeda dibanding kombinasi lainnya. Sebagai contoh, frekuensi 

tertentu mungkin belum menimbulkan memar yang besar pada durasi singkat, tetapi dapat 

meningkatkan luas memar secara nyata pada durasi yang lebih lama. Sebaliknya, pada frekuensi yang 

lebih rendah, penambahan durasi mungkin tidak memberikan perubahan memar yang berarti. Adanya 

interaksi yang signifikan ini menunjukkan bahwa mekanisme pembentukan memar pada pisang 

selama simulasi transportasi bersifat kompleks dan dipengaruhi oleh kombinasi perlakuan, bukan 

hanya oleh satu faktor tunggal. 

Secara umum, hasil ini mengindikasikan bahwa respon memar pisang pada threshold 150 

lebih dipengaruhi oleh kombinasi frekuensi dan durasi getaran dibandingkan oleh durasi secara 

tunggal, sementara frekuensi menunjukkan kecenderungan pengaruh yang mendekati signifikan. 

Oleh sebab itu, pembahasan hasil penelitian sebaiknya tidak hanya berfokus pada efek utama masing-

masing faktor, tetapi terutama pada pola interaksi antara frekuensi dan durasi. Dengan adanya 
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interaksi yang nyata, interpretasi biologis dan teknis menjadi lebih relevan apabila dilakukan melalui 

perbandingan rerata pada setiap kombinasi perlakuan, misalnya dengan menelaah kombinasi 

frekuensi–durasi mana yang menghasilkan persentase area memar tertinggi dan terendah. Pendekatan 

ini akan memberikan gambaran yang lebih jelas mengenai kondisi getaran yang paling berisiko 

terhadap kerusakan mekanis buah pisang selama transportasi dan penyimpanan. 

Hasil uji lanjut Duncan (Gambar 6) pada variabel persentase area memar threshold 150 

(T150) menunjukkan bahwa interaksi antara frekuensi getaran dan durasi getaran membentuk tiga 

subset homogen, yang menandakan bahwa kombinasi perlakuan memberikan respons memar yang 

berbeda-beda. Kombinasi F10D60 menghasilkan rerata persentase area memar paling rendah, 

yaitu 1,9713%, diikuti oleh F10D30 sebesar 2,6501% dan F20D90 sebesar 3,1037%. Sebaliknya, 

kombinasi F30D60 menunjukkan rerata persentase area memar tertinggi, yaitu 6,9786%. Pola ini 

memperlihatkan bahwa tingkat kerusakan mekanis pisang selama simulasi transportasi tidak hanya 

dipengaruhi oleh satu faktor tunggal, tetapi oleh kombinasi antara intensitas getaran dan lamanya 

paparan getaran. 

 

Gambar 6. Hasil uji lanjut Duncan terhadap interaksi 

 

Rendahnya persentase area memar pada kombinasi 10 Hz–60 menit menunjukkan bahwa pada 

frekuensi yang relatif rendah, energi getaran yang diterima buah kemungkinan belum cukup besar 

untuk menghasilkan benturan berulang yang signifikan antar buah atau antara buah dengan dinding 

kemasan. Dalam sistem transportasi hortikultura, memar terjadi ketika jaringan buah menerima gaya 

mekanis yang melampaui ambang elastisitasnya sehingga sel-sel di bawah epidermis mengalami 

kerusakan, yang kemudian tampak sebagai diskolorasi cokelat atau kehitaman pada kulit buah 

(Hussein et al., 2020; Opara & Pathare, 2014). Getaran berfrekuensi rendah dengan durasi sedang 

pada penelitian ini tampaknya belum mendorong akumulasi energi benturan yang cukup besar, 

sehingga luas area memar yang terbentuk relatif kecil. Temuan ini sejalan dengan kajian transportasi 

pascapanen yang menyatakan bahwa kerusakan mekanis buah tidak hanya ditentukan oleh adanya 

getaran, tetapi juga oleh intensitas getaran, arah getaran, posisi buah dalam kemasan, dan sifat 

mekanik buah itu sendiri (Fernando et al., 2018; Opara et al., 2022). 

Sebaliknya, tingginya persentase area memar pada kombinasi 30 Hz–60 menit menunjukkan 

bahwa frekuensi getaran yang lebih tinggi pada durasi tertentu dapat memperbesar risiko kerusakan 

mekanis. Secara mekanistik, peningkatan frekuensi getaran dapat meningkatkan jumlah siklus osilasi 
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yang diterima buah per satuan waktu, sehingga peluang terjadinya tumbukan, gesekan, dan tekanan 

berulang pada permukaan buah menjadi lebih besar. Apabila kondisi ini terjadi secara terus-menerus 

selama simulasi transportasi, jaringan buah dapat mengalami kegagalan struktural, baik berupa 

pecahnya dinding sel maupun kerusakan membran sel, yang kemudian memicu pencoklatan jaringan 

dan pembentukan memar (Hussein et al., 2020; Van Zeebroeck et al., 2007). Pada pisang, kerusakan 

mekanis selama transportasi sangat penting karena buah ini termasuk komoditas klimakterik yang 

sensitif terhadap benturan; memar tidak hanya menurunkan penampilan visual, tetapi juga dapat 

mempercepat respirasi, meningkatkan laju pemasakan, dan memperpendek umur simpan (Al-Dairi 

et al., 2024; Fernando et al., 2019). 

Hasil Duncan juga memperlihatkan bahwa beberapa kombinasi perlakuan, 

seperti F30D90, F30D30, dan F20D60, berada pada subset yang saling tumpang tindih. Kondisi ini 

menunjukkan bahwa walaupun rerata persentase area memar berbeda secara numerik, beberapa 

kombinasi perlakuan tidak berbeda nyata secara statistik. Secara biologis, fenomena ini dapat 

dijelaskan oleh sifat memar buah yang sangat dipengaruhi oleh variasi internal buah, seperti tingkat 

kematangan, kekerasan jaringan, kadar air, ukuran buah, dan posisi buah terhadap sumber getaran 

selama simulasi transportasi (Hussein et al., 2020; Opara & Pathare, 2014). Dengan demikian, 

respons memar yang dihasilkan oleh satu kombinasi frekuensi–durasi tertentu dapat bertumpang 

tindih dengan kombinasi lainnya apabila energi mekanik yang diterima buah masih berada pada 

kisaran yang menghasilkan tingkat kerusakan yang serupa. Pada frekuensi rendah, penambahan 

durasi belum tentu langsung meningkatkan memar apabila amplitudo gerakan atau percepatan buah 

masih rendah. Sebaliknya, pada frekuensi yang lebih tinggi, durasi paparan tertentu dapat 

memperbesar peluang terjadinya resonansi atau penguatan transmisi getaran pada kemasan, sehingga 

memperparah memar (Fernando et al., 2018; Opara et al., 2022). Hal ini menjelaskan mengapa 

kombinasi 30 Hz–60 menit justru menghasilkan memar tertinggi, sementara 10 Hz–60 

menit menghasilkan memar terendah, walaupun keduanya memiliki durasi yang sama. 

Secara praktis, hasil ini menunjukkan bahwa kombinasi perlakuan getaran perlu 

dipertimbangkan secara simultan dalam upaya menekan kerusakan mekanis pisang selama 

transportasi. Kombinasi 10 Hz–60 menit dapat dipandang sebagai kondisi simulasi yang relatif lebih 

aman karena menghasilkan memar paling rendah, sedangkan kombinasi 30 Hz–60 

menit menunjukkan kondisi yang paling berisiko menimbulkan kerusakan. Informasi ini penting 

untuk perancangan sistem transportasi dan pengemasan pisang, karena pengendalian getaran tidak 

cukup dilakukan hanya dengan membatasi lama transportasi, tetapi juga perlu memperhatikan 

karakteristik frekuensi getaran yang diterima buah selama distribusi. Dengan demikian, hasil uji 

Duncan tidak hanya memperjelas kombinasi perlakuan yang berbeda nyata, tetapi juga memperkuat 

pemahaman bahwa kerusakan memar pada pisang merupakan respons dinamis terhadap interaksi 

antara intensitas dan durasi getaran selama penanganan pascapanen (Al-Dairi et al., 2024; Fernando 

et al., 2019; Opara et al., 2022). 

 

4. Kesimpulan 

Kesimpulan dari penelitian ini sebagai berikut: 

1. Screening threshold pada nilai 120, 130, 140, 150, dan 160 menunjukkan bahwa seluruh 

threshold memiliki hubungan yang sangat kuat dalam merepresentasikan persentase area memar 

pisang. 

2. Hasil Principal Component Analysis (PCA) menunjukkan bahwa threshold 120–160 berada 

pada satu dimensi informasi yang sama, sehingga seluruh threshold pada dasarnya mengukur 

fenomena yang serupa, yaitu luas area memar pisang. 
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3. Pemilihan threshold terbaik tidak hanya didasarkan pada hasil statistik PCA, tetapi juga 

mempertimbangkan kualitas segmentasi visual citra agar area memar dapat terdeteksi secara 

jelas, stabil, dan minim noise. 

4. Interaksi antara frekuensi getaran dan durasi getaran berpengaruh sangat nyata terhadap 

persentase area memar pisang, yang menunjukkan bahwa tingkat memar dipengaruhi oleh 

kombinasi kedua perlakuan, bukan oleh satu faktor secara terpisah. 

5. Hasil uji lanjut Duncan menunjukkan bahwa kombinasi frekuensi 10 Hz dan durasi 60 menit 

menghasilkan persentase area memar terendah, yaitu 1,9713%. 

6. Secara keseluruhan, hasil penelitian menunjukkan bahwa threshold 150 layak digunakan 

sebagai dasar kuantifikasi memar pisang, dan kerusakan memar selama simulasi transportasi 

dipengaruhi secara nyata oleh interaksi frekuensi dan durasi getaran. 
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